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Preface 

This guide describes how to install the product on the supported platform. 

 

Product Name: UCA Automation 

Product Version: 1.2 

Read this document before installing or using this software. 

Intended audience 
This document is intended for the solution developers and software development engineers. 

Software versions 
The term UNIX is used as a generic reference to the operating system, unless otherwise specified. 

The software versions referred to in this document are as follows. 

 

Product version Supported operating systems 

UCA Automation 1.2 Linux Red Hat Enterprise Linux Server release 6.4 

Table 1 Software versions 

Typographical conventions 
 

Courier Text It is used for filenames and their contents, computer inputs or 
outputs, program codes, and so on. 

Italicized text It is used for labels, parameters, emphasized text, and replaceable 
text. 

bold text It is used to indicate navigation options in the interfaces; for 
example, the text appearing in buttons and menu items. 

<angle brackets> Indicates generic variable names that must be substituted by real 
values or strings. 

 

Associated documents 
The following documents contain useful reference information: 

 HP UCA for Event Based Correlation Installation Guide 

 HP UCA for Event Based Correlation Topology Extension Guide 

 HP UCA for Event Based Correlation Value Pack Development Guide 

 Deployment Manager (HPSA) Guide 

 NOM Installation and Configuration Guide 
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 UCA HPSA CA Main Release Guide 

 UCA Autoconsole CA Main Release Guide 

 NOM UCA EBC Channel Adapter Installation Guide 

 NOM TEMIP Channel Adapter Installation Guide  

Support 
Visit the HP Software Support Online Web site at www.hp.com/go/hpsoftwaresupport for contact information, 

and details about HP Software products, services, and support. 

The Software support area of the Software Web site includes the following:  

 Downloadable documentation.  

 Troubleshooting information.  

 Patches and updates.  

 Problem reporting.  

 Training information.  

 Support program information. 

 

http://www.hp.com/go/hpsoftwaresupport


8 

 

Introduction 

This guide describes the installation procedure for the UCA Automation solution. 

1.1 Local install descriptors 
The following locations are used to define install locations throughout this guide. 

Descriptor Description 

${ACTIVATOR_OPT} The base install directory of Service Activator. The UNIX® 

location is /opt/OV/ServiceActivator. 

${SOLUTION_ETC} The etc directory of the HPSA value pack solution. 

${UCA_EBC_HOME} The root directory of UCA-EBC.  

The default value is /opt/UCA-EBC. 

${UCA_EBC_DATA} The data directory of UCA-EBC.  

The default value is /var/opt/UCA-EBC. 

${UCA_EBC_INSTANCES} This directory might contain multiple instances of UCA-

EBC where the value packs are deployed.  

The path refers to 

${UCA_EBC_DATA}/instances/default. 

${NOM_INSTANCE} /var/opt/ openmediation-

70/containers/<instance-#> 

Table 2 Local install descriptors 
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System requirements 

 

2.1 Server platforms 
Red Hat Enterprise Linux 6.4 

 UCA-EBC 3.1 

 HPSA V6.2-1A 

 NOM 7.0 

2.2 Hardware requirements 
 X86-64 based system 

 At least 4 GB of memory 

 The database system requires a space for an Oracle 11g or an Enterprise Database 

Postgres 9.2 database instance of at least 4 GB for the product data. 

2.3 Software requirements 
 

2.3.1 HP UCA-EBC 

 UCA for Event Based Correlation Server V3.1 and the latest patches.  

 Installing the UCA-EBC 3.1 server patch 00005 is mandatory. 

 UCA for Event Based Correlation Topology Extension. 

2.3.1.1 Configure HP UCA EBC 

Edit the ${UCA_EBC_INSTANCES}/conf/uca-ebc.properties file to add the 

following configuration to integrate the UCA Automation UI login with UCA EBC. 

UCA_Automation_Foundation_UCA-V1.2-1A-UCAAutomation-webapp-

parameters=username=${user},userrole=${role} 

Update the ${UCA_EBC_INSTANCES}/conf/GraphDisplayProfiles.xml 

file with the following configuration. 

 

<Profile name="ucaatm" displayedName="Decision Tree View" 

defaultProfile="true"> 

  <DefaultNode> 

    <Icon> 

      <MainIcon>images/round.jpg</MainIcon> 
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      <Decorations attributeName="status"> 

        <Decoration 

attributeValue="Warning">images/warningLarge.png 

        </Decoration> 

        <Decoration 

attributeValue="Failed">images/critical.png</Decoration> 

        </Decorations> 

      </Icon> 

      <Text> 

        <Color>0 0 0</Color> 

        <Font>SansSerif</Font> 

        <Size>10</Size> 

        <Emphasis>plain</Emphasis> 

        <DisplayedName>[${name}]</DisplayedName> 

      </Text> 

      <GetNeighbors automatic="true" level="20"> 

       <Queries> 

        <Query><![CDATA[START startNode = node({nodeID})  

MATCH (startNode)<-[relationship]->(endNode) RETURN 

startNode, relationship, endNode;]]></Query> 

       </Queries> 

      </GetNeighbors> 

     </DefaultNode> 

    <DefaultRelationship> 

      <LineType>line</LineType> 

      <SourceHead>none</SourceHead> 

      <TargetHead>halffilledarrow</TargetHead> 

      <DisplayedName>${Type}</DisplayedName> 

    </DefaultRelationship> 

</Profile> 

Restart UCA-EBC server. 

2.3.2 HP Service Activator 

 HP Service Activator version 6.2 - V62-1A and the latest patches 

 Oracle 11g or Postgres Plus Advanced Server 9.2. The database can be installed on the 

same server or can be accessed remotely (but it must be located in the same sub 

network). You can also use an existing database that is used by another application. In 

that case, you need to create a new database user (if Oracle is used) or a new database 

instance (if Postgres Plus Advanced Server is used) for the exclusive use by Service 

Activator and UCA Automation. 

 To validate the Domain Example of UCA Automation 1.2, deploy CRModel Solution of 

HPSA. 
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  

  

  

 

2.3.3 NOM 

 OSS Open Mediation V7.0 and latest patches 

# rpm -qa| grep ngossopenmediation 

ngossopenmediation-7.0.0-RHEL5.noarch 

# nom_admin --list-ip-in-container 

DEPLOYED        nom-basic-smx-components 
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DEPLOYED        smx-basic-components 

 UCA for Event Based Correlation Channel Adapter V3.1 

# rpm -qa | grep UCA-EBCCA 

UCA-EBCCA-V3.1-00A.noarch 

# nom_admin --list-ip-in-container| grep uca-ebc-ca 

DEPLOYED        uca-ebc-ca-3.1  

 The TeMIP Channel Adapter: if your solution involves TeMIP  

# rpm -qa | grep -i ngosstemip-ca 

ngosstemip-ca-2.0.0-RHEL5.noarch 

# nom_admin --list-ip-in-container| grep temip-ca-20 

DEPLOYED        temip-ca-20 

2.3.4 Configure TeMIP Channel Adaptor for UCA Automation 

Note 

This configuration is optional. 

 

Validate the TeMIP configuration in the file. 

Edit the ${NOM_INSTANCE}/ips/temip-ca-

20/etc/conf/TeMIP_configuration.dynamic.xml file.  

For example, if the TeMIP Director is configured on the ossdemo1.ind.hp.com 

host, the file should contain the following configuration: 

<TeMIPDirectorEntity>.temip.ossdemo1_temip</TeMIPDirectorEn

tity> 

Edit the ${NOM_INSTANCE}/ips/temip-ca-

20/etc/conf/TeMIP_configuration.dynamic.xml to add the custom 

attributes required for UCA Automation within the tags. 

<CustomAttributes> 

………………… 

</CustomAttributes> 

<CustomAttribute> 

  <Attribute>Action</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Actionidlist</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Actionstatus</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Evp</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Evpscenario</Attribute> 

  <Datatype>XmlString</Datatype> 

 </CustomAttribute> 

  

<CustomAttribute> 
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  <Attribute>Outputparameters</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Problem</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Rawresult</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Resourceinstance</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Serviceinstance</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Taskid</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Initiator</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

 

<CustomAttribute> 

  <Attribute>Originatingfms</Attribute> 

  <Datatype>XmlString</Datatype> 

</CustomAttribute> 

Edit the ${NOM_INSTANCE}/ips/temip-ca-20/etc/actions.to-

temip.ao.request.uca-to-tws.xslt file and add the custom attributes 

required for UCA Automation in the <!-Specific output nodes > tag. 

<!-- Specific output nodes --> 

<xsl:template name="Action"> 

   <xsl:call-template name="simple_node"> 

      <xsl:with-param name="input_node" 

select="command/entry[key='Action']" /> 

   <xsl:with-param name="output_node_name" 

select='"Action"' /> 

       </xsl:call-template> 

    </xsl:template> 

    <xsl:template name="Actionidlist"> 

      <xsl:call-template name="simple_node"> 

        <xsl:with-param name="input_node" 

select="command/entry[key='Actionidlist']" /> 

        <xsl:with-param name="output_node_name" 

select='"Actionidlist"' /> 

      </xsl:call-template> 

    </xsl:template> 

    <xsl:template name="Actionstatus"> 

      <xsl:call-template name="simple_node"> 

        <xsl:with-param name="input_node" 

select="command/entry[key='Actionstatus']" /> 
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        <xsl:with-param name="output_node_name" 

select='"Actionstatus"' /> 

       </xsl:call-template> 

     </xsl:template> 

     <xsl:template name="Evp"> 

       <xsl:call-template name="simple_node"> 

         <xsl:with-param name="input_node" 

select="command/entry[key='Evp']" /> 

         <xsl:with-param name="output_node_name" 

select='"Evp"' /> 

         </xsl:call-template> 

       </xsl:template> 

       <xsl:template name="Evpscenario"> 

         <xsl:call-template name="simple_node"> 

            <xsl:with-param name="input_node" 

select="command/entry[key='Evpscenario']" /> 

         <xsl:with-param name="output_node_name" 

select='"Evpscenario"' /> 

        </xsl:call-template> 

       </xsl:template> 

       <xsl:template name="Outputparameters"> 

          <xsl:call-template name="simple_node"> 

            <xsl:with-param name="input_node" 

select="command/entry[key='Outputparameters']" /> 

            <xsl:with-param name="output_node_name" 

select='"Outputparameters"' /> 

           </xsl:call-template> 

        </xsl:template> 

        <xsl:template name="Problem"> 

           <xsl:call-template name="simple_node"> 

             <xsl:with-param name="input_node" 

select="command/entry[key='Problem']" /> 

             <xsl:with-param name="output_node_name" 

select='"Problem"' /> 

             </xsl:call-template> 

        </xsl:template> 

      <xsl:template name="Rawresult"> 

        <xsl:call-template name="simple_node"> 

          <xsl:with-param name="input_node" 

select="command/entry[key='Rawresult']" /> 

          <xsl:with-param name="output_node_name" 

select='"Rawresult"' /> 

        </xsl:call-template> 

        </xsl:template> 

        <xsl:template name="Resourceinstance"> 

        <xsl:call-template name="simple_node"> 

           <xsl:with-param name="input_node" 

select="command/entry[key='Resourceinstance']" /> 

           <xsl:with-param name="output_node_name" 

select='"Resourceinstance"' /> 

          </xsl:call-template> 

       </xsl:template> 

       <xsl:template name="Serviceinstance"> 

       <xsl:call-template name="simple_node"> 

       <xsl:with-param name="input_node" 

select="command/entry[key='Serviceinstance']" /> 

       <xsl:with-param name="output_node_name" 

select='"Serviceinstance"' /> 

      </xsl:call-template> 

     </xsl:template> 

    <xsl:template name="Taskid"> 

      <xsl:call-template name="simple_node"> 
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      <xsl:with-param name="input_node" 

select="command/entry[key='Taskid']" /> 

      <xsl:with-param name="output_node_name" 

select='"Taskid"' /> 

      </xsl:call-template> 

     </xsl:template> 

    <xsl:template name="Initiator"> 

      <xsl:call-template name="simple_node"> 

      <xsl:with-param name="input_node" 

select="command/entry[key='Initiator']" /> 

      <xsl:with-param name="output_node_name" 

select='"Initiator"' /> 

     </xsl:call-template> 

     </xsl:template> 

     <xsl:template name="Originatingfms"> 

        <xsl:call-template name="simple_node"> 

        <xsl:with-param name="input_node" 

select="command/entry[key='Originatingfms']" /> 

        <xsl:with-param name="output_node_name" 

select='"Originatingfms"' /> 

      </xsl:call-template> 

    </xsl:template> 

 

Add the following entry under the <!-- CREATE: 27 items --> tag. 

<!-- **************** --> 

<xsl:if test="($request_type='Create')"> 

 

<xsl:call-template name="Action" /> 

 <xsl:call-template name="Actionidlist" /> 

 <xsl:call-template name="Actionstatus" /> 

 <xsl:call-template name="Evp" /> 

 <xsl:call-template name="Evpscenario" /> 

 <xsl:call-template name="Outputparameters" /> 

 <xsl:call-template name="Problem" /> 

 <xsl:call-template name="Rawresult" /> 

 <xsl:call-template name="Resourceinstance" /> 

 <xsl:call-template name="Serviceinstance" /> 

 <xsl:call-template name="Taskid" /> 

 <xsl:call-template name="Originatingfms" /> 

 <xsl:call-template name="Initiator" /> 

Add the following entry under <!-- SET: 82 items of Attribute List --> 

 

<xsl:variable name="of_type_timestamp" 

select="('Acknowledgement_Time_Stamp',...,  

                      'Pb',  

                      'Parents', 

                      'Children',  

                      'Action', 

    'Actionidlist', 

    'Actionstatus', 

    'Evp', 

    'Evpscenario', 

    'Outputparameters', 

    'Problem', 

    'Rawresult', 

    'Resourceinstance', 

    'Serviceinstance', 

    'Taskid', 

    'Initiator', 

    'Originatingfms')"/> 
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Redeploy the TeMIP channel adaptor. 

#nom_admin --undeploy-ip-in-container temip-ca-20 

#nom_admin --deploy-ip-in-container temip-ca-20 

2.3.5 JAVA 

If UCA-EBC and HPSA reside on the same server then use Java SE 6 update 37 JDK or a later version (as HPSA 

does not support JAVA 1.7). 

2.3.6 Configure TeMIP 6.2L 

Note 

This configuration is optional. 

 

When TeMIP 6.2L is used as NMS, perform the following: 

Install and configure TeMIPV62L with the latest available patches. 

For more details, refer to the TeMIP Installation Guide for Linux. 

Install and configure TeMIP Web Services with the latest patches. 

For more details, refer to the TeMIP WebServices Installation and Administration Guide.  

Set TeMIP Web Services Security' level to none. 

Run the following command to update the TeMIP dictionary with custom attributes 

required for UCA EBC 3.1. 

/usr/opt/temip/bin/temip_ah_user_defined_attr -project TPD 

Run the following command to update the TeMIP dictionary with custom attributes 

required for UCA Automation. 

/usr/opt/temip/bin/temip_ah_user_defined_attr -project TND 

2.3.7 Configure TeMIP when used as NMS 

Note 

This configuration is optional. 

 

When TeMIP is used as an NMS, configure TeMIP using the following procedure. 

Enter the TeMIP management and run the following commands. 

$ manage 

TeMIP Framework (V6.2.0) 

 

TeMIP> create domain uca_dom  

Domain tfrsol1_ns:.uca_dom 

On director: tfrsol1_ns:.temip.tfrsol1_director 

AT Mon 11 Mar 2013 06:54:49 

 

Entity successfully created. 

 

TeMIP> create oper uca_network assoc domain uca_dom 

OPERATION_CONTEXT tfrsol1_ns:.uca_network 

On director: tfrsol1_ns:.temip.tfrsol1_director 

AT Mon 11 Mar 2013 06:55:29 

 

Operation Context successfully created 
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TeMIP> create oper uca_pbalarm assoc domain uca_dom 

OPERATION_CONTEXT tfrsol1_ns:.uca_pbalarm 

On director: tfrsol1_ns:.temip.tfrsol1_director 

AT Mon 11 Mar 2013 06:56:07 

 

Operation Context successfully created 

 

TeMIP> register oper uca_network 

OPERATION_CONTEXT tfrsol1_ns:.uca_network 

On director: tfrsol1_ns:.temip.tfrsol1_director 

AT Mon 11 Mar 2013 06:56:22 

 

Registration successful. 

 

TeMIP> register oper uca_pbalarm 

OPERATION_CONTEXT tfrsol1_ns:.uca_pbalarm 

On director: tfrsol1_ns:.temip.tfrsol1_director 

AT Mon 11 Mar 2013 06:56:36 

 

Registration successful. 

 

2.4 Web client 
 Mozilla Firefox 32 

 Google Chrome 37 

 



18 

 

UCA Automation solution pack 

This chapter includes the procedures to install the following components: 

 UCA Automation Solution Pack 

 HPSA Foundation Value Pack 

 UCA EBC Foundation Value Pack 

 UCA Automation UI 

 NOM Channel Adapters 

3.1 Installing UCA Automation solution 
The UCA Automation solution is delivered as a tar file named: 

uca-automation-kit-1.2-linux.tar 

To install the package, perform the following operations: 

1. As root user, untar the archive in a temporary local directory (For example: /tmp): 

# cd /tmp 

# tar -xvf <kit location>/uca-automation-kit-1.2-linux.tar 

2. Run the installation script. 

Depending on whether you wish to install the UCA Automation at the default location, i.e. 

/opt/UCA_UCAAutomation, or an alternate location, run either of the following commands to execute the 

installation script. 

To install UCA Automation at the default location (in /opt/UCA_Automation directory), please execute the 

following command as root user: 

# install-uca-automation.sh 

To install UCA Automation at an alternate location of your choosing, please execute the 

following command as root user: 

# install-uca-automation.sh –r <root directory> 

If unspecified, the default root directory for UCA Automation is /opt/UCA_Automation. 

Before running the installation script ensure that UCA_EBC_HOME is set to UCA-EBC 

Home Directory 

Note 

Installing UCA Automation as non-root user (Linux only): 

 

For some very specific needs UCA Automation package can be installed by a non-root 

user. This feature is available for Linux only. 

When installing UCA Automation as non-root user, the following limitations must be 

understood and acknowledged: 
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a. The system RPM database is not accessible by a non-root user. As a 

consequence, when installation is performed by a non-root user, a specific 

RPM database must be specified. The default RPM repository for non-root 

installation is set to ~/.rpmdb (where ~ is the user home directory). This 

directory can be overridden by specifying the –-rpmdbpath option as 

installation script argument. 

b. The UCA Automation root directory must be read/write accessible by the non-

root user. Usually the default /opt/UCA_Automation directory cannot be used 

(unless some specific rights have been set by the administrator). As a 

Consequence, when installation is performed by a non-root user, the –r option 

must be specified 

c. When installed by the non-root users the UCA Automation scripts will only be 

executable by the user who performed the installation 

The script installs the package under root directory specified by the user. The following 

directories are created. 

 Orchestration_Plugin 

 UCAAutomationOrchestrator.jar 

 TeMIP_Integration 

 TEMIPTFRLIN_00172.tar 

 TEMIPTFRLIN_00172.text 

 UCA_Automation_ChannelAdapters 

 uca-autoconsole-ca-2.0.0-L.tar 

 uca-hpsa-ca-2.0.0-L.tar 

 UCA_Automation_HPSA_VPs 

 UCA_HPSA_DomainExample_VP-V12-1A.zip 

 UCA_HPSA_FoundationVP-V12-1A.zip 

 UCA_Automation_UCA_VPs 

 UCA_Automation_DomainExample_UCA_EV-vp-V1.2-1A.zip 

 UCA_Automation_Foundation_UCA-vp-V1.2-1A.zip 

 UCA_Automation_DomainExample_UCA_PD-vp-V1.2-1A.zip 

 Licenses 

 bin 

 uninstall-uca-automation.sh 

 Utilities 

 DecisionTree 

 TomSawyerVisualization 

 

Artifact Description 

TEMIPTFRLIN_00172.tar TeMIP Server Patch – User Defined 

Attributes 

uca-autoconsole-ca-2.0.0-L.tar UCA-Automation Console Channel 

Adapter 

uca-hpsa-ca-2.0.0-L.tar UCA-HPSA Channel Adapter 
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Artifact Description 

UCA_HPSA_DomainExample_VP-V12-1A.zip HPSA example VP 

UCA_HPSA_FoundationVP-V12-1A.zip HPSA Foundation VP 

UCA_Automation_DomainExample_UCA_EV-

vp-V1.2-1A.zip 

UCA EBC example evaluate value pack 

UCA_Automation_Foundation_UCA-vp-V1.2-

1A.zip 

UCA EBC Foundation VP 

UCA_Automation_DomainExample_UCA_PD-

vp-V1.2-1A.zip 

UCA EBC example PD value pack 

Table 3  RPM artifacts 

3. Verify if the package is installed successfully. 

a.     Run the following command: 

# rpm -qa | grep -i Automation 

UCA_Automation-V1.2-REV_A.noarch 

b. Uninstall the packages by running the uninstall-uca-automation.sh provided 

in <UCA Automation root>/bin: 

When the uninstall-uca-automation.sh tool is launched, it checks for all UCA Automation packages installed on 

your system and prompts you for the number associated with the package to be uninstalled 

# /opt/UCA_Automation/bin/uninstall-uca-automation.sh  

You should get an output similar to the following text 

# here is the list of installed UCA Automation packages: 

 

        [0]     UCA_Automation-V1.2-REV_A.noarch 

 

Enter the index number of UCA Automation version to un-

install ('Enter' to Cancel):  

By entering ‘0’ (as in the example above), UCA Automation version V1.2 will be removed 

3.2 Installing HPSA Foundation value pack 
 

3.2.1 Deploy HPSA Foundation value pack 

The HPSA foundation value pack is delivered as a ZIP file named UCA_HPSA_FoundationVP-V12-1A.zip.  

As a root user, copy the ZIP file of the foundation value pack to the 

${ACTIVATOR_OPT}/SolutionPacks directory. 

Import and deploy the Foundation Value Pack solution.  

For details, refer the Deployment Manager Guide. 

Make sure that the Create Inventory Table checkbox is selected. 

For information on undeploying and deleting the HPSA solution pack, refer to the 

Deployment Manager Guide. 

3.2.2 Configure HPSA Foundation value pack 

As a root user, run the config.sh script in the ${SOLUTION_ETC}/config directory.  
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The script enables the httpsender module in the MWFM.xml file of the HPSA with the 

web service URL hosted in the HPSA Channel Adaptor. When the HTTPsender module is 

enabled, it sends the responses to the  Automation Console. 

 

# cd /opt/OV/ServiceActivator/solutions/UCA/etc/config 

# chmod +x ./config.sh 

# ./config.sh 

Setting up the Service Activator UCA Foundation Value 

Pack... 

 

Configuring MicroWorkFlow Manager 

(/etc/opt/OV/ServiceActivator/config/mwfm.xml)... 

===========================================================

==== 

 

UCA HTTP Sender module... 

Enter Host name/IP address of the web service hosted in 

HPSA Channel Adaptor 

[localhost] :  

Enter port for web service hosted in HPSA Channel Adapter 

[ 8191 ] : 

8191 

(Saving mwfm.xml for future reconfiguration) 

 

/etc/opt/OV/ServiceActivator/config/mwfm.xml configured 

 

Done setting up Service Activator Foundation Value Pack 

 

Log file: 

/var/opt/OV/ServiceActivator/log/tfrsol1/ucasp.install.0318

13_013907.log 

 

Changes in Service Activator configuration files 

may be inspected in files: 

/var/opt/OV/ServiceActivator/log/tfrsol1/uca.mwfm.xml.diff 

 

Press enter to continue... 

The following is a snippet of the mwfm.xml file. 

 

Reload the configuration from the HPSA UI or restart HP Service Activator. 
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3.3 Installing UCA EBC Foundation value pack 
The UCA Automation foundation value pack is delivered as a ZIP file named 

UCA_Automation_Foundation_UCA-vp-V1.2-1A.zip. 

Copy the ZIP file of the foundation value pack to the 

${UCA_EBC_INSTANCES}/valuepacks directory. 

Deploy the Foundation value pack. 

For details, refer the UCA for Event Based Correlation Value Pack Development Guide. 

Edit the ${UCA_EBC_DATA}/instances/default/conf/uca-ebc-

log4j.xml file. 

Add the following section in the file under the root tag <log4j:configuration>, 

specifically below the comment line Detailed Traces for Value Pack 

Scenarios: 

 

<logger 

name="UCA_Automation_Foundation_UCA.requestresponse" 

additivity="false"> 

  <level value="TRACE" /> 

  <appender-ref ref="CONSOLE" /> 

  <appender-ref ref="FILE" /> 

</logger> 

 

<logger name="UCA_Automation_DomainExample_UCA_EV.evaluate" 

additivity="false"> 

  <level value="TRACE" /> 

  <appender-ref ref="CONSOLE" /> 

  <appender-ref ref="FILE" /> 

</logger> 

 

3.3.1 Configure UCA Automation UI 

Edit the UCAAutomation.properties file in the 

${UCA_EBC_INSTANCES}/deploy/UCA_Automation_Foundation_UCA-

V1.2-1A/conf directory. 

Update the localhost with UCA EBC Server hostname. 

ucaebc_tomsawyer_port=http://localhost:8888/graphdisplay/?u

sername=root&nodeId=0&profile=ucaatm 

Update the database. 

o If you have an enterprise database Postgres, use the following configuration. 

DB_DRIVER=org.postgresql.Driver 

DB_URL=jdbc:postgresql://<db-host>:<db-port>/<db> 

DB_USER=<db-user> 

DB_PASSWORD=<db-user-password> 

o If you have Oracle 11g database, use the following configuration. 

DB_DRIVER=oracle.jdbc.driver.OracleDriver 

DB_URL=jdbc:oracle:thin:@<db-host>:<db-port>:<db> 

DB_USER=<db-user> 

DB_PASSWORD=<db-user-password> 

Edit the ExternalActionConfig.xml file available in the 

${UCA_EBC_INSTANCES}/deploy/UCA_Automation_Foundation_UCA-

V1.2-1A/conf directory and edit the following line with the UCA EBC server host 

name and port: 
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<consoleurl> 

http://localhost:8888/UCA_Automation_Foundation_UCA-V1.2-

1A-UCAAutomation/UCAService 

</consoleurl> 

If TeMIP is used as NMS, start the UCA_Automation_Foundation_UCA value pack.  

If TeMIP is not the NMS, before starting the UCA_Automation_Foundation_UCA value 

pack, delete the mediation flow in UCA_Automation_Foundation_UCA value pack. 

 

Figure 1 Deleting the Mediation Flow from UCA_Automation_Foundation_UCA value pack 

 

3.4 Installing UCA Automation UI 
 

3.4.1 Deploy UCA Automation UI 

The UCA Automation UI is embedded in UCA Automation Foundation value pack and is delivered as a war file. 

Deploy and start the UCA Automation Foundation value pack to view the UCA Automation UI. 
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UCA Automation Orchestrator 

The UCA Automation 1.2 release provides an Eclipse plug-in to create and deploy UCA Automation Orchestrator. 

4.1 Prerequisites for installing Orchestrator 
Eclipse Kepler version 4.3.2 

4.2 Install UCA Automation Orchestrator 
 

4.2.1 Install EMF plug-in 

Open Eclipse. 

Select Help -> Install New Software. 

Install EMF from the following site: 

http://download.eclipse.org/modeling/emf/emf/updates/release

s/ 

Select All and click NEXT to install the software. 
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4.2.2 Install GEF plug-in 

Open Eclipse. 

Select Help -> Install New Software. 

Install GEF from the following site: 

http://download.eclipse.org/tools/gef/updates/releases 

Select All and click NEXT to install the software. 

 

 

4.2.3 Install Windows builder 

Install the Windows builder directly from the following location: 

http://download.eclipse.org/windowbuilder/WB/release/R201309

271200/4.3/ 

Place the UCAAutomationOrchestrator.jar file in the dropins folder of the 

Eclipse.  

Restart the Eclipse. 

Note 

If the UCAAutomationOrchestrator.jar file is updated, after placing the updated 

JAR file in the dropins folder of Eclipse, restart Eclipse with a -clean option.   

 

To verify whether the plug-in is installed, select Help -> About Eclipse -> Installation 

details -> Plugins.  

The following Plug-ins tab in the Eclipse Installation Details window contains the 

plug-in name. 
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4.3 Configure Orchestrator 
After loading Eclipse, select Window -> Preferences -> General -> Workspace.  

Select the checkbox for Refresh on access. 

 

Configure the Active Provider in Eclipse to improve the upload performance of the 

decision tree.  

Select Window -> Preferences -> General -> Network Connections.  

Set the Active Provider to Direct. 
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4.4 Decision tree command line utility 
Edit the GraphDBUtilities.properties file available under the 

${UCA_AUTOMATION_ROOT}/utilities /DecisionTree/conf/ directory. 

#UCA Automation Inventory database connection details 

#Oracle jdbc driver : 

#oracle.jdbc.pool.OracleConnectionPoolDataSource 

#Oracle url : jdbc:oracle:thin:@<hostname>:<port>:<service> 

#Postgres jdbc driver : com.edb.Driver 

#Postgres url : jdbc:edb:@<hostname>:<port>:<service> 

inventory.db.driver=com.edb.Driver 

inventory.db.url=jdbc:edb://<hostname>:<port>/<service> 

inventory.db.user=<username> 

inventory.db.password=<password> 

 

#Neo4j database connection details 

neo4j.db.protocol=http 

neo4j.db.host=localhost 

neo4j.db.port=7474 

neo4j.db.db=db 

neo4j.db.data=data 

#enables batch transaction of inserts into neo4j db 

org.neo4j.rest.batch_transaction=true 

#enables http streaming 

org.neo4j.rest.stream=true 

 

The following is a snippet of the GraphDBUtilities.properties file. 
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Properties Description 

inventory.db.driver Database driver name. 

inventory.db.url The connection URL. 

inventory.db.user The login user name of database. 

inventory.db.password The login password associated with the user name 

neo4j.db.protocol By default it is http. 

neo4j.db.host By default it is localhost. This is the hostname/IP 

address of the server where neo4j is hosted. 

neo4j.db.port By default it is 7474. The port number where neo4j 

is hosted. 

neo4j.db.db By default it is db 

neo4j.db.data By default it is data 

org.neo4j.rest.batch_transaction Enables batch transaction of inserts into neo4j 

org.neo4j.rest.stream Enables http streaming 

Table 4 Neo4j configuration descriptors 
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Install NOM channel adaptors 

 

5.1 HPSA channel adaptor 
To install and deploy the HPSA Channel Adaptor, follow the instructions in the UCA HPSA CA Main Release Guide. 

Edit the config.properties file in the ${NOM_INSTANCE}/ips/uca-hpsa-ca-20/etc. 

# HPSA connectivity settings 

hpsa.host=0.0.0.0 

hpsa.port=<HPSA port> 

hpsa.userid=<HPSA user with StartJob privileges> 

hpsa.password=<password for the above HPSA user> 

 

# UCA Automation controller workflow 

hpsa.controller.workflow.name=UCAController 

 

# UCA Automation response handler connectivity settings 

hpsa.uca-automation.sync-service.host=0.0.0.0 

hpsa.uca-automation.sync-service.port=8191 
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The following is a snippet of the config.properties: 

 

 

Descriptor Description 

hpsa.host Hostname /IP address of the server where HPSA is 

hosted.  

hpsa.port The listening port of  HPSA  

hpsa.userid The login user name of HPSA. The user has the permission 

to start and stop a job, as well as check the status. 

hpsa.password The login password associated with the user name 

hpsa.uca-automation.sync-

service.host 

The default value is 0.0.0.0. This is the hostname/IP 

address of the internal web service being hosted by HPSA 

CA 

hpsa.uca-automation.sync-

service.port 

The default value is 8191. The listening port number of 

the internal web service hosted by CA. 

hpsa.controller.workflow.name The name of the HPSA foundation workflow to be invoked 

in HPSA. You cannot change the value. 

Table 5 HPSA CA config descriptors 

5.2 UCA Automation console channel adaptor 
To install and deploy the Automation Console Channel Adaptor, follow the instructions in the UCA Autoconsole 

CA Main Release Guide. 

Edit the config.properties file in the ${NOM_INSTANCE}/ips/uca-autoconsole-ca-20/etc 

directory. 

uca.uca-automation.host=0.0.0.0 

uca.uca-automation.port=12500 

uca.console.service=UCA_Automation_Foundation_UCA-V1.2-1A-

UCAAutomation/UCAService 

uca.console.host=localhost 

uca.console.port=<uca-ui.properties - ucaui.gui.port> 
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The following snippet from the config.properties file contains sample values: 

 

 

Descriptor Description 

uca.uca-automation.host Host name or the IP address of Automation console CA where 

the internal webservice is hosted. 

The default value is  0.0.0.0. 

uca.uca-automation.port Listening port of the internal Automation console CA web 

service. The default value is 12500. 

uca.console.service Name of the automation console web service. 

uca.console.host The Hostname /IP address of the server where the UCA 

Automation console is hosted. 

uca.console.port The listening port of the UCA Automation console.  

See section 6.2, uca-ui.properties - ucaui.gui.port  

Table 6 UCA Console CA config descriptors 
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UCA Automation licensing 

A 60-day Instant-On license is installed by default when UCA-EBC Automation Foundation value pack is started. 

This license activates all features of the product for a trial period. After the expiration of the trial period, an 

extended evaluation or a commercial license is needed to continue using the product. 

For any questions related with licensing, please contact the UCA Automation product management team.  

6.1 Get a UCA Automation license 
You need a license key to use the UCA Automation software. Licensing is managed by AutoPassJ, which is 

automatically installed with UCA for EBC. You must obtain a license key to continue using the product after the 

60-day trial period. 

The following is the process for getting a license key: 

Log in as a system administrator of the product and access the Webware web site 

(www.webware.hp.com). 

Download the perpetual license to use the product.  

To request perpetual license keys, you should have the following information: 

o Entitlement Certificate—Contains the HP product number and order number 

(Entitlement order number). 

o Contact information of the license owner—Details of your company or 

organization. 

(Optional) Contact the HP Password Center via fax, email, or phone.  

For more information, refer to the Password Request Form and the License Entitlement 

Certificate. To get product licenses, you should have the License Entitlement Certificate. 

6.2 License policy 
When the UCA-EBC Automation Foundation Value Pack for EBC Server starts, the system runs a license check for 

UCA Automation feature. 

To activate this feature, you should have a valid license key. The UCA-EBC Automation Foundation value pack 

does not start if you do not have a valid license key for the UCA Automation feature. 
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The following table shows the link between UCA Automation product part numbers and the features: 

Product part 

number 

Description Enabled UCA Automation features 

JK461AAE HP UCA Automation Foundation 

Prod E-LTU 

HP UCA Automation Foundation 

Prod E-LTU 

HP OSS UCA Expert Production 

HP OSS UCA Expert DB 

HP Service Activator Tier X ELTU 

JK462AAE HP UCA Automation Foundation 

Non-Prod E-LTU 

HP UCA Automation Foundation 

Non-Prod E-LTU 

HP OSS UCA Expert Production 

HP OSS UCA Expert DB 

HP Service Activator Tier X ELTU 

 

When you activate the UCA Automation Instant-On feature, UCA Automation automatically generates a 

corresponding license key which is added to the license.txt file available under the 

${UCA_EBC_DATA}/instances/<instance name>/licenses folder. By default the directory path is 

/var/opt/UCA-EBC/instances/default/licenses. 

This license.txt file contains all license keys. For information on installing the licenses, refer to the UCA-

EBC and HP Service Activator Installation Guides. 

6.3 Use Webware website for product licenses 
The following procedure discusses how to obtain your product licenses. 

Go to www.webware.hp.com.  

The HP Licensing for Software website opens. 

Click the Sign In button.  

The HP Passport Sign-in page appears. 

Sign in using the user ID and password associated with your HP Passport.  

If you do not have an HP Passport account, request for one by clicking the New users - 

Please register link. 

Click Sign In. 

The home page of the HP Licensing for Software web site opens. 

Enter your entitlement order number in the Entitlement order number (EON) text box.  

You order number is displayed on the License Entitlement Certificate (HP Order 

Number). 

Click Go. 

In the Entitlement column, select the checkboxes for the products for which you want 

license keys. 

Click Activate. 

For each product you selected, enter the number of Licenses to Use (LTUs) in the Qty 

field.  

The number of licenses is limited by the total number of LTUs available for the order.  
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For each product you selected, enter the required details in the Target field. 

It includes the following: Server host name, IP address for the system where the 

software is installed, and so on. 

Click Finish. 

A confirmation message appears stating that an email containing the license keys has 

been sent to you. The page also displays the license keys and provides links for 

emailing and displaying them along with the information regarding the product 

activation. 

6.4 Install license keys for UCA Automation 
The following procedure discusses how to install license keys for UCA Automation. 

After you get the UCA Automation license key, copy the license key to the 

license.txt file available under the 

${UCA_EBC_DATA}/instances/<instance name>/licenses folder. 

The default location is /var/opt/UCA-EBC/instances/default/licenses. 

If you want to copy more than one license key to the license.txt file, append them 

to the license.txt file one after the other until all license keys are copied to the 

license.txt file. 

Restart the UCA for EBC Server to apply the changes made to the license.txt file. 

6.5 Remove license keys for UCA Automation 
The following procedure discusses how to remove license keys for UCA Automation. 

Remove the license keys from the license.txt file located in the 

${UCA_EBC_DATA}/instances/<instance name>/licenses folder. 

The default location is /var/opt/UCA-EBC/instances/default/licenses. 
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Code signing 

This software product from HP is digitally signed and accompanied by Gnu Privacy Guard (GnuPG) signatures. HP 

strongly recommends using signature verification on its products, but there is no obligation. Customers have 

the choice of running this verification or not as per their IT Policies. 

7.1 Install and configure Gnu Privacy Guard (GnuGP) 
If you do not have GnuGP installed, you should download and install GnuGP. For information about obtaining 

and installing GnuGP, see http://www.gnupg.org 

Before verifying the signatures delivered on the HP Service Activator DVD, you should configure GnuGP for 

accepting the HP signature. Use the following procedure to configure GnuGP: 

Log into your system. 

Get the HP public key from following location: 

https://h20392.www2.hp.com/portal/swdepot/displayProductInfo

.do?productNumber=HPLinuxCodeSigning 

Save the key as hpPublicKey.pub.  

Import the key into GnuPG by running the following command  

gpg --import hpPublicKey.pub 

7.2 Verify authenticity and integrity in RHEL 6.4 
This section explains the procedure to verify the signatures of the software packages to assess the integrity of 

the software before installation. 

In the command prompt, go to the home directory on the DVD and run the following command: 

gpg --verify uca-automation-kit-1.2-linux.tar.sig uca-

automation-kit-1.2-linux.tar 

You should get the following output from the gpg command: 

gpg: Good signature from "Hewlett-Packard Company (HP Code 

signing Service)" 

 

http://www.gnupg.org/
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Glossary 

Term Description 

UCA Unified Correlation Analyzer 

EBC Event Based Correlation 

IP Installation Package for OSS Open Mediation V6.2 

JDK Java Development Kit 

JMS Java Messaging Service 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

Inference Engine Process that uses a Rete algorithm 

DRL Drools Rule file 

XML Extensible Markup Language 

XSD Schema of an XML file, describing its structure 

NOM NextGen OSS Open Mediation 

CA NOM Channel Adapter 

PPAS Postgres Plus Advanced Server 
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